
© 2008 DivX, Inc.

DivX Player for Windows User Guide



DivX Player for Windows User Guide

1

Install & Setup
Basics�����������������������������������������������������������������������������3
Download & Installer walk-through ���������������������������������������3
Registration (for purchased products)������������������������������������4
Who, what, huh?���������������������������������������������������������������5

Intro to GUI & Basic Controls
Getting started������������������������������������������������������������������6
Layout�����������������������������������������������������������������������������6
About Video Display modes������������������������������������������������8
Menus����������������������������������������������������������������������������9
Right-click options����������������������������������������������������������� 10
File information��������������������������������������������������������������� 12
Keyboard shortcuts���������������������������������������������������������� 13

How To
Playback controls������������������������������������������������������������ 15
Multiple audio tracks�������������������������������������������������������� 15
Subtitles������������������������������������������������������������������������ 16
External subtitles������������������������������������������������������������ 18
Media library������������������������������������������������������������������ 18
Download manager��������������������������������������������������������� 20
Burning������������������������������������������������������������������������� 21
Creating a DivX VOD account�������������������������������������������� 23
Changing account info������������������������������������������������������ 24
Using the Device Manager������������������������������������������������ 25
DFX Audio Enhancer Plug-In��������������������������������������������� 26
Purchasing DFX�������������������������������������������������������������� 26
Using DFX during playback����������������������������������������������� 27
Making DivX Player the default media player������������������������� 28

Finding DivX content
Finding DivX content�������������������������������������������������������� 29
About DivX VOD������������������������������������������������������������� 29

Table of Contents



DivX Player for Windows User Guide

2

Table of Contents (cont.)

Device registration����������������������������������������������������������� 30
Device Manager�������������������������������������������������������������� 30
Registering through the Device Manager����������������������������� 31

Miscellaneous
Playback performance����������������������������������������������������� 34
Rendering���������������������������������������������������������������������� 34
The Decoder Configuration Utility��������������������������������������� 35
More info����������������������������������������������������������������������� 37



DivX Player for Windows User Guide

3

Basics
DivX Player is the official video playback software application 
for DivX® video content and is available on Windows and Mac 
operating systems. At this time, there is no Linux version of 
DivX Player. You can download DivX Player for free from DivX.
com. 

Recent additions to DivX Player provide improved playback 
performance. DivX Player 6.8 or higher has the ability to play 
files larger than 4GB, meaning improved playback for larger 
high definition videos. In addition to playing your .divx and .avi 
files encoded with DivX Codec, DivX Player can play most 
other popular file formats such as those in the .wmv container, 
provided you have the necessary DirectShow filters installed on 
your system. You will also be able to play QuickTime .mov and 
.mp4 files in DivX Player for Windows 6.8 or higher if you have 
QuickTime 7 or higher installed.

 

Download & installer walk-through 
When you download the DivX software bundle from DivX.
com you will first see an installation (.exe) file. Depending on 
your Internet browser, you will receive one of the two following 
prompts:

Install & Setup
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Install & Setup (cont.)

Internet Explorer:

Internet Explorer:

Firefox:

Firefox:

First, click ‘Run’ or ‘Save’ in Internet Explorer, or ‘Save File’ 
in Firefox, then click the button to ‘Open’ or ‘Run’ the DivX 
installer. The set-up wizard will open, prompting you to select a 
language and some basic install preferences.

Registration (for purchased products)
If you have downloaded DivX Player as part of your DivX Pro 
for Windows purchase, or if you have added the DFX Audio 
Enhancer, you can register your products very easily from the 
Start menu. If you downloaded the free version of the software, 
you do not need to register anything because … well, it’s free! 

To register your purchased product, select: 
	 All Programs >
	 DivX >
	 DivX Codec >
	 Register Products
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Intro to GUI & Basic Controls

The Registration window will appear and you can enter your 
serial number in the space provided. Click the ‘Register’ button 
to complete registration. 

When your products have been successfully registered, 
the serial number will disappear and the status displayed 
to the right of the product name in this window will change 
to “Registered.” If you get an error message that the serial 
number wasn’t accepted, it may have simply been mistyped. 
Try copying and pasting your serial number to make sure 
no characters were missed or accidentally changed, and 
be careful not to leave any extra spaces before or after the 
number.

Who, what, huh?
“And what, may I ask, is a GUI?” 

The acronym GUI (pronounced “gooey”) or Graphical User 
Interface, refers to the visual 2D design of a program on your 
computer.

In other words, it’s everything that makes up the application 
window and its various parts. DivX Player GUI has various 
buttons, boxes, windows and menus, which are all arranged 
into four main areas that surround the central media pane.
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Intro to GUI & Basic Controls (cont.)

Getting started
To use DivX Player either double-click on the desktop shortcut 
(these are generally created automatically during installation – 
if you haven’t removed them you can use these shortcuts as an 
easy reference) or find the application under the Start menu > 
Programs > DivX folder.

Layout
DivX Player opens displaying the central media pane and the 
controls panes on each side. You’ll see the menus at the top, 
the Media Library on the left, the burning engine on the right 
and playback controls on the bottom. 

At the top of the left pane are two view buttons. Clicking either 
of these buttons changes the central screen display between 
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Intro to GUI & Basic Controls (cont.)

Media Library (on the left) and Media View (on the right). The 
central pane will open to the Media View first, where your 
video will play. If you change this to display the Media Library, 
you will see a list of all your video files stored in DivX Player’s 
Media Library.

Below the two view buttons is the Media Library pane, giving 
you options to manage the videos you see in your Media 
Library view.

This includes an “All Videos” section for files that have been 
added to the library—both DivX Video-on-Demand downloads 
and files imported from your hard drive. There’s also the 
Download Manager, showing downloaded files, their download 
progress and status.

At the bottom are the names of any Playlists you have created 
for your Media Library files.
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Intro to GUI & Basic Controls (cont.)

The right-hand pane is the burning queue and engine. Get 
more information on how to burn files in the “How To” section 
of this guide.

The bottom-center pane shows (from left to right) the basic 
playback controls, including the Play, Stop, Fast-Forward 
and Rewind buttons. This section also contains a scrolling 
bar showing the playback progress of the video and can be 
dragged to skip backwards or forwards; buttons for entering 
Full Screen mode, selecting audio and subtitle tracks, menus 
and chapters, opening the DFX Audio Enhancer control 
window, the volume control bar, and the ‘Open file’ button. 
Also, you’ll see a small blue pane that shows the total length 
and time elapsed of the selected video.

About Video Display modes
If you want to minimize and see only the central media 
pane, close the exterior panels by clicking on the arrow tabs 
extending from the left and right panes. Click the arrows again 
to reopen the pane. Or, to hide the entire GUI and show only 
the media pane you can choose the über minimal ‘Compact 
Mode’ by either right-clicking on your media pane and choosing 
Video Display > Compact Mode or using the shortcut Alt + C. 
If you want to see your video in all its glory, check out the ‘Full 
Screen Mode’ using the right-click menu, the keyboard shortcut 
(Alt + Return) or the bottom button for Full Screen Mode. You 
can exit Full Screen Mode by repeating the same action again 
or by pressing the ‘Esc’ key.
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Intro to GUI & Basic Controls (cont.)

Menus
Here is a basic breakdown of each option in the three drop-
down menus at the top-left of DivX Player. Most of them are 
self-explanatory. More complex functions are covered in detail 
in the “How To” section, so this is simply a summary of the 
drop-down menu functions.

File: 

Open:•	  Find and select a file on your computer for playback 
Open URL…:•	  There’s no need to download it to your computer 
first; just paste the video file URL and download while you watch. 
(More on how to do this later…) 
Open Recent File:•	  See a list or go back to the videos you 
watched last
Import File(s) to Library:•	  Add one or more videos to the Media 
Library (to select multiple, hold down the Ctrl key as you select 
each file)
Import Folder to Library:•	  Same as ‘Import File’, but for an entire 
folder of videos at once
Create New Playlist:•	  Make an empty playlist to which you can 
later add videos from the Media Library 
Exit:•	  You guessed it. As in, “Close the window and shut down the 
program.”

Tools:

User Account:•	  Create or log in to your account to watch DivX 
VOD content on your PC 
Device Manager:•	  Register a DivX Certified device (e.g. DVD 
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Intro to GUI & Basic Controls (cont.)

player) to play DivX VOD content on a compatible DVD player, 
mobile phone, etc.  
Audio Enhancer:•	  Opens the DFX Audio Enhancer, which 
enriches the playback quality of your videos’ soundtracks 
Preferences:•	  From the general to the specific; more info on this 
in “Right-click options” below

Help:

DivX Player Help:•	  Links to the DivX Support site to ask a 
question or search FAQs 
Keyboard Shortcuts:•	  In case you don’t want to look them up in 
this guide later ;-)
DivX Player Version History:•	  Links to a webpage logging the 
changes to each of the past versions
Forgotten Password…:•	  In case you can’t remember your 
password to log in to your account
DivX Author—Create DivX Movies:•	  Online info about our video 
authoring program 
Send us your Feedback:•	  An online survey for customer 
satisfaction. Yes, we do care about what you have to say! 
About the DivX Player:•	  Get details about your DivX Player 
version and currently selected video file

Right-click options
You can access important settings for the application by right-
clicking your mouse over the media pane. A menu will appear 
with options leading to other menus for tuning and tweaking 
settings and defaults to your heart’s content. Some of these 
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Intro to GUI & Basic Controls (cont.)

are accessible from other locations or shortcuts, so if the name 
causes you a little déjà vu, you’ll know why.

Video Display: 

Normal:•	  Watch the video in the default DivX Player window
Compact:•	  Watch the video with a simplified window 
Full Screen:•	  Fill your monitor with video playback; no skin, no 
controls, nada 
Set Aspect Ratio:•	  Choose 4:3, 16:9, set a “Custom” ratio or 
“Free” ratio to best suit your video’s resolution or your monitor, or 
just because you can
Change Video Size:•	  Zoom your video in or out without changing 
your Video Display mode

Preferences: 

General:•	  Manage the global settings for the DivX Player 
application 

Default Media Folder:•	  The folder where your downloaded 
video files will be saved 
General Preferences:•	  Enable or disable banner ads, and 
change application window settings 
Startup and File Opening:•	  Select what you prefer to see first 
when you open the program 

Media Library:•	  Manage the library settings for DivX Player 
Media Library Settings:•	  Default settings for downloading and 
importing files 
Default View:•	  Choose your preferred view for the media pane 
on startup 
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Intro to GUI & Basic Controls (cont.)

When Importing Files:•	  Designate whether to play the files 
from their stored location or make a copy to the DivX Player 
Media Library 

Playback:•	  Manage your playback settings 
Playback Options:•	  Loop your video, turn off screen savers or 
disable the DivX interactive menus (more on this later)
Default Playback View:•	  Normal, Full screen or Compact 

Language:•	  Manage audio and subtitle track settings 
Audio Settings:•	  Set default language for your soundtracks 
Subtitle Settings:•	  Set default language for your subtitles 
External Subtitles:•	  Enable file detection and choose more 
subtitle display preferences 

Video:•	  Manage image and decoder settings 
Playback Quality:•	  Adjust post-processing, sharpening and 
deblocking settings for a smoother picture 
Image Settings:•	  Set brightness, contrast, saturation and 
intensity to personalize your playback 

Advanced:•	  Manage advanced settings for the DivX Player 
application 

Restore Player Defaults:•	  Restore all the settings you just 
changed back to their default values
Video Output:•	  Use the default ‘Best Available’ renderer to 
decode your video, or switch to Direct 3D, Direct Draw or 
OpenGL 

File information
Selecting ‘File Information’ lets you look up some basic 
information about your video file such as its location on 



DivX Player for Windows User Guide

13

Intro to GUI & Basic Controls (cont.)

your hard drive or metadata. Choosing this option opens a 
small window displaying the file name, location, video tracks 
with codec, resolution and frame rate, and audio or subtitle 
tracks and their respective details. This can be useful if you 
want to check program compatibility or change any playback 
preferences to best suit the video file.

Tracks, Menus, Chapters: 

Audio Tracks:•	  Turn off audio, see and select available audio 
track(s), or access the audio settings 
Subtitle Tracks:•	  Turn off subtitles, see and select available 
subtitle track(s), or access subtitle settings 
Menus:•	  Access menus for root, title, chapters, audio or subtitles, 
where available. Or go straight to the main feature (i.e. your 
video) 
Chapters:•	  If your file has chapter points, you can see and select 
them here.

Keyboard shortcuts
Shortcuts are displayed in the right-click menu next to the 
respective action (when available) or they can be accessed 
through the Help menu. Here is a cheat sheet of keyboard 
shortcuts available in DivX Player:

Play/Pause:•	  [SPACE BAR]
Compact Mode:•	  [Alt] > [C]
Rewind:•	  [Ctrl] > [<-]
Full screen Mode:•	  [Alt] > [Enter]
Fast Forward:•	  [Ctrl] > [->] 
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Intro to GUI & Basic Controls (cont.)

Normal Size:•	  [Alt] > [1]
Stop:•	  [Ctrl] > [SPACE BAR]
Half Size:•	  [Alt] > [2] 
Open a File:•	  [Ctrl] > [O] 	
Double Size:•	  [Alt] > [3] 
Preferences:•	  [Ctrl] > [P] 	
Exit:•	  [Alt] > [F4] 
Main Menu:•	  [M]
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How To

Playback controls
The basic playback controls for opening and watching your 
videos in DivX Player are located beneath the media pane 
where your video plays. You can choose to play your video in 
DivX Player two ways. The first is to find the file at the location 
that it is saved on your computer and choose to open it with 
DivX Player. If DivX Player is your default program for your 
DivX files, double-clicking the file name will automatically 
open DivX Player and begin playing the video. If not, you can 
right-click the file name; select “Open with…” and choose DivX 
Player from the list.

The second way to play your video in DivX Player is to open 
the program first, either through the desktop shortcut or your 
Start menu. Once the program is open, you can go to the 
File menu and select Open, or click the ‘open’ button in the 
playback controls bar (This is the button located to the right 
of the volume control). An open dialog box will appear for you 
to find your file on your computer. Select the file, click ‘OK’ 
and then select Play to watch the video. You can pause, fast-
forward, rewind or stop playing at any time using the buttons to 
the bottom of the Player.

Multiple audio tracks
If your video has more than one audio track (e.g. for other 
languages) you can switch between these easily while playing 
your video or set one language as your default. 

To switch between audio tracks, right click on the media pane 
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How To (cont.)

then select ‘Audio Tracks.’ In the next menu, choose the track 
you want to play. Click ‘OFF’ to disable audio, or go to “Audio 
Settings…” to manage the language preferences. The DivX 
Player Preferences window will open. Under ‘Audio Settings,’ 
check the box to use default audio settings when available and 
select your preferred language from the drop-down menu. Click 
‘Apply’ then ‘OK’ to return to playback. 

If your video did not come with a secondary audio track but 
you have acquired one that you would like to add to your video, 
you can join the audio file to the video file using a muxing tool 
such as DivXMuxGUI. Once the audio has been “muxed” (i.e. 
joined) to the video, the additional audio track will be available 
for playback in DivX Player. 

Subtitles
If your video has subtitles, you can choose which set of 
subtitles to use and set defaults in the same way you access 
your audio tracks. 



DivX Player for Windows User Guide

17

How To (cont.)

Right-click on the central media pane in DivX Player and select 
‘Subtitle Tracks’ from the list. ‘OFF’ will disable subtitles and 
a checkmark shows which track is chosen for playback. To 
choose a different track, just click on its name.

For subtitle preferences, select “Subtitle Settings…” The DivX 
Player Preferences window will open. Under ‘Subtitle Settings,’ 
check the box to use default subtitle settings. Pick your 
language from the drop-down menu. Click ‘Apply’ then ‘OK.’

If your subtitles are in an external file (e.g., an srt file) then 
you can select these when you open the video file by following 
these steps:

Go to File and select ‘Open’ •	
Navigate to your video file •	
Highlight the file name to select it •	
Check the ‘Use a specific subtitle file’ box •	
Click the button […] to the bottom-right. •	
Browse to the location of the subtitle file •	
Highlight the file name to select it •	
Click ‘Open’ then ‘OK’ •	

To join the external subtitle file permanently to your video, use 
the DivXMuxGUI tool in the same way you would join your 
audio files.
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How To (cont.)

External subtitles
If you want DivX Player to automatically detect a corresponding 
.srt subtitle file, make sure you have the files named properly 
and saved to the correct location. External subtitles can be 
opened in text editors such as Notepad; but they must have 
a subtitle suffix, such as .srt, rather than the .txt text file 
extension. The .srt file needs to be in the same folder as 
the video file and have the same file name of the video. For 
example, if your video file is “myvideo.divx” the subtitle file 
would be “myvideo.srt.”

If you are using foreign characters, you may want to save the 
file in a different encoding format. Generally, the UTF-8 format 
works well. To change the character encoding setting, open 
the file in Notepad and select Save As > (All Files) Encoding: 
UTF-8. Changing this will usually correct any display problems 
associated with subtitles using character encoding other than 
ASCII.

If your subtitles are not displaying, try disabling the advanced 
hardware overlay. Go to Start > All Programs > DivX > DivX 
Codec > Decoder Configuration Utility. Select the Decoder 
tab and under Video Settings, uncheck the box that says “Use 
advanced hardware overlay.” 

Media library and playlists
To create a new playlist, click on the create playlist button 
located in the bottom left-hand corner of DivX Player. (It looks 
like a little folder with a “+” on it.)
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How To (cont.)

A new window will appear where you can name the list. Write 
the playlist name and click ‘OK.’ Your newly created playlist will 
appear in the Media Library. 

You can now select your videos for the playlist from the Media 
Library’s All Videos view by clicking and dragging the file over 
to the playlist name, or by right-clicking and selecting ‘Add to 
Playlist…’

To play movies in your playlist simply select the first movie you 
wish to play and double-click or click the play icon. 

You also have the following options when you right-click on 
your playlist:

Play Playlist •	
Rename Playlist •	
Add to Burn Queue•	
Remove Playlist •	
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How To (cont.)

Download manager
The Download Manager is a tool that manages all the DivX 
videos you download from websites selling DivX Video-on-
Demand (VOD) content. DivX VOD downloads require you to 
log in to your DivX Player account for authentication purposes. 

Once user authorization is complete, DivX Player begins 
downloading the video file while displaying the completion 
percentage. The time required to download a video depends 
on the size and length of the video being downloaded and your 
Internet connection speed. You can pause your video download 
at any point during the download process. When you want 
to resume your download, all you need to do is re-open the 
Download Manager, choose your video and click the ‘Resume 
Download’ link. 

Another DivX Player feature is progressive playback which 
allows you to watch files while they are still being downloaded. 
By estimating your bandwidth DivX player is able to determine 
if your download speed is faster than your playback speed 
and/or you have downloaded enough of the video that your 
playback won’t catch up with your download. This means if you 



DivX Player for Windows User Guide

21

How To (cont.)

have a DSL or cable connection, you may only have to wait a 
few minutes to start playing back your 90-minute video! 

Since DivX VOD files are not streaming, you only have to 
download the file once. Once you complete the download, you 
don’t have to wait for the video to be pushed to your computer 
again or be interrupted with variable bandwidth speed and the 
annoyance of buffering, because the videos will play directly 
from your hard drive.

Burning
Burning your videos to a CD or DVD in DivX Player is very 
easy. There are two ways to burn videos to disc. The first 
method is through DivX Player’s Media Manager and the 
second method uses a file manager such as Windows Explorer 
or a My Computer window.

From the Media Manager in DivX Player, right-click on the 
file(s) you want to burn and select “Add to Burn Queue.” If 
selecting more than one file, hold down the Ctrl key while you 
select the filenames with your cursor.
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How To (cont.)

You can also add the file to the burn queue by simply dragging 
and dropping the file on the burn motor (the big round button 
on the right side). Just click on your video file to select it, drag 
it onto the big round button and release to drop the file.

From the Windows file manager, just drag and drop the video 
file from the Explorer window onto the big round button in the 
burning pane of DivX Player. Click on the ‘Burn’ button to begin 
burning your disc. 

To delete a file from your burn queue, just click to select the 
movie and press the delete or backspace key or use the ‘Clear’ 
button. You can select several files from the list to delete at 
once. When deleting a file from your file manager, you won’t 
delete the original file unless you select to do so.

The files are sorted in alphabetical order when burned to a 
piece of media. Also, you can change the name of your disc in 
the Volume Name text field.
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How To (cont.)

You can view the total file size or the space remaining on your 
disc (DVD or CD) below the orange burning image. If the files 
exceed the total size limit of your media, DivX Player will not let 
you burn the files.

Click on the ‘Burn’ button to start burning your video file(s) to 
your disc.

Once the burning starts, the disc will show you the burning 
steps and the percentage of files burned. It will take only a few 
minutes to burn files. Once this process is finished, a status 
window will appear with the message “Burn successful, you 
have successfully written X of X files to disc.” This window will 
also give you the option to clear the burn queue.

Creating a DivX VOD account
If you are purchasing DivX Video-on-Demand (VOD) content, 
you will need to create an account in DivX Player that will be 
used to authenticate your purchases. This should be created 
with the same email address that is used to buy the content 
online. 

If you do not currently use DivX VOD services, you do not 
need to create an account. Regular, non-VOD DivX files do not 
require authentication. 

You can create an account in DivX Player to watch content 
bought from DivX VOD services. Use this to validate your 
viewing rights or register your DivX Certified devices. To create 
an account open DivX Player, go to the Tools menu and select 
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‘User Account.’ In the account log in window, click the ‘Create 
Account’ button in the bottom left corner.

In the create account window, you will be asked for basic 
information such as your name, email address and password. 
Fill out all the fields then click the ‘Create Account’ button. 
We’ll send you a confirmation email with a link to complete the 
creation of your account. If you don’t see the email initially, 
double check in your email junk folders as the account needs 
to be verified before you can watch your DivX VOD content.

Changing account info
To change the details of your account, log in as usual through 
the Tools menu. Once logged in you can change your name, 
security question and answer, or password by deleting the 
existing details and writing the new information in its place. 
Don’t forget to click on the ‘Update Account’ button to save 
your changes. 

If you forgot your password, go to the Help menu and select 
“Forgotten Password…” Answer your security question and an 
email will be sent to you with a link to change your password.
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Using the Device Manager
If you’re tired of watching videos on your relatively-small 
computer screen, why not kick back in front of your TV for a 
more comfortable viewing experience or take multitasking to a 
new level by taking your videos on the go? 

If you have a DivX Certified device, the Device Manager lets 
you set it up for viewing DivX Video-on-Demand content on 
these bigger or smaller screens any time you feel like it. Any 
DivX Certified device will play non-VOD files, but for DivX VOD 
the device must be registered to your account.

You can access your Device Manager in the same way as you 
create or log in to your DivX Player account. Just go to the 
Tools menu of DivX Player and select Device Manager. (We’ll 
explain more later…)
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DFX Audio Enhancer Plug-In
The DFX Audio Enhancer Plug-In trial comes automatically 
installed with DivX Player. You can try the DFX Audio Enhancer 
for free during the first 30 days after the software is installed.

Purchasing DFX
The DFX Audio Enhancer can be purchased at any time during 
or after the free trial. To purchase, open the DivX Player and go 
to Tools > Audio Enhancer… or just click the DFX button in the 
playback control pane.

In the DFX window, select the ‘Help’ button, then select “Register 
DFX…” to begin the purchase process. You’ll see a button to pur-
chase a DFX serial number that will take you to a check-out cart. 
The purchased serial number can be entered here or via the Start 
menu.
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Using DFX during playback
You may be wondering what exactly DFX is, or how it can 
better your video experience. 

Most of the digital audio in videos transferred via the Internet 
is compressed to save space. This is great for sending files, 
but the quality of the soundtrack is consequently compromised. 
This is what is meant by “lossy compression.” 

The DFX plug-in in your DivX Player restores the audio back 
to nearly its original quality, delivering a richer, fuller and more 
dynamic experience.

When you access the DFX Audio Enhancer window, five main 
components affecting sound can be adjusted to your personal 
preference for speech or for two music processing modes.

Simply click the square radio buttons to the left of the five 
components to unlock access to the controls. 
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When the mode’s button is green, you can use the slider bars 
to adjust the levels of each audio enhancing feature.

Making DivX Player the default media player
The easiest way to make DivX Player your default media player 
is to select a video to watch with the DivX Player. Right-click on 
the file, roll over “Open With” and select “Choose Program…” 
Now select DivX Player from the list and be sure to mark the 
box labeled “Always use the selected program to open this kind 
of file.” The DivX Player is now the default player for this type of 
file.
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Finding DivX content
DivX video has been shared on the Internet since 1999. All 
DivX video files will play back on any PC or DivX Certified 
device. However, DivX VOD content comes only from a DivX 
partner’s video service. 

An example of free, non-VOD DivX video content that can be 
found online is deviantART Film. The site features the DivX 
media format as the default “high-quality” viewing option for 
users. Check out some of the innovative DivX videos available 
on the site by visiting http://browse.deviantart.com/film/. You 
can watch these films and animation pieces on your computer 
or download the videos to play them back on any DivX Certified 
device.

About DivX VOD
DivX partners with VOD providers to offer you the opportunity 
to rent and purchase video from a diverse group of sites. Any 
DivX video content purchased from these VOD providers will 
be playable on your computer by logging into your DivX Player 
account or any DivX Certified device that you have registered 
to that account. 

The DivX Video on Demand (VOD) system uses DivX 
Digital Rights Management (DRM), a security technology 
infrastructure responsible for protecting copyrights while 
enabling you to legally rent and purchase video online. For 
more detailed information on how this works, read our DivX 
VOD FAQ article. 

Finding DivX content
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Finding DivX content (cont.)

In the DivX VOD system, content belongs to a user account 
rather than individual computers or devices, so you can simply 
log in to your DivX Player account on any computer with an 
Internet connection to view videos. An internet connection is 
required to play the DivX VOD content because DivX Player is 
a network application that communicates with the video service 
to authenticate rights. 

In addition, thanks to the DivX Certified Program, DivX VOD 
content can also be played on consumer electronics devices 
that are DivX Certified. Every DivX Certified device is required 
to support the DivX VOD system.

Device registration
If you purchase a DivX Certified device (DVD Player, TV, 
portable media player, mobile phone, etc.) and have also 
purchased DivX VOD content online from one of our partners, 
you simply need to associate the device with your account 
to view DivX VOD content on it. Once you have activated the 
device for your account, you can burn the VOD content to disc 
or other portable media storage supported for playback. Read 
on for instructions on how to set up this capability.

Device Manager
If you have a DivX Certified device and purchase DivX VOD 
content, then this information about the Device Manager is 
relevant to you. If not, you can skip this section.
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DivX Certified consumer electronics devices let you watch your 
DivX videos away from your computer. From home theater 
systems to portable media players and in-car players to new 
mobile phones – you can watch your DivX videos wherever 
you want. Any DivX Certified device can play your own DivX 
videos. However, in order to watch your DivX VOD rentals and 
purchases on your certified device, you will need to complete 
a one-time registration of your device in your DivX Player 
account. You can register up to six DivX Certified devices with 
your DivX Player account. This means you can watch your DivX 
VOD content on up to six different devices.

Device registration is quick and easy. To start, you will need to 
get your device’s VOD registration code. Generally speaking, 
you should be able to find your DVD player’s activation code 
for the DivX VOD system pretty easily by searching through 
the device’s on-screen menus with the remote control. Some 
manufacturers also include the DivX VOD registration code in 
the manual for the device. We also have more information for 
DivX Certified players in our DivX VOD section on DivX.com. 
If you’re having issues registering, please contact the maker of 
the device directly.

Registering through the Device Manager
Once you have found your VOD code, start the activation 
process by logging into your account through DivX Player’s 
Device Manager. To log in, select the Device Manager from 
the Tools menu. When the Device Manager window opens, you 
may be prompted to either log in or create a DivX VOD account 
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(which is separate from a DivX Support account). Click on the 
‘Register Device’ button to begin the process. The “Activate 
Device” window will open where you can select the brand of 
the device you want to activate. 

Scroll down the alphabetical list of names, click on your 
device’s name to highlight it and click ‘Next.’ Enter your VOD 
code under the “Activation ID” section, and in the “Name” 
section give your device a label or nickname. The name you 
choose for your device is entirely up to you. Once you have 
entered this information, click ‘Next’ again. The activation 
should begin, which will be indicated by a green progress bar 
and percentage.
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When the activation progress bar shows it’s complete, you’re 
almost done. Click ’Next’ and you will be given the option to 
choose a method of transfer for the Activation Video. You can 
choose either to burn the file to a disc (CD or DVD) or you 
can save it to your computer if you have a network-connected 
device. You MUST play the activation video on your device to 
complete the activation process. Select your storage location 
and click ‘Finish Activation.’

Select the “Burn to Disc” option if you have an optical disc 
based player (e.g., set-top DVD player, portable DVD player) 
and burn the “DivX Activation Video.divx” file to a CD or DVD. If 
you have a hard disc drive or flash memory-based player (e.g., 
portable media player), add the “DivX Activation Video.divx” 
file to the storage device of your player. (Refer to the player’s 
instruction manual on how to add media files to the device.) If 
you have a network-based player (e.g., network media player), 
add the “DivX Activation Video.divx” file to the media library 
directory of the hosting/server software. (Refer to the player’s 
instruction manual on how to add media files to the hosting/
server software.) Next, follow the manufacturer’s instruction 
and play the “DivX Activation Video” file on your DivX Certified 
player. You should see the “Activation Successful” video on 
your TV or screen when this last step is completed. 

Congratulations! Your DivX Certified device is now activated for 
DivX Video-on-Demand.
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Playback performance
There are several steps you can take to improve DivX playback 
performance. First, make sure you have the most up-to-date 
drivers for your graphics card and the latest version of DirectX. 
You will also want your hardware and DirectDraw accelerations 
to be fully enabled. To check your hardware acceleration 
settings, open the “Display Properties” control panel and click 
the “Settings” tab followed by the ‘Advanced’ button. Finally, 
click on the “Troubleshoot” tab to ensure that your Hardware 
Acceleration is set to “Full.” Also make sure your Color Quality 
is set to “24-bit or higher.” 

To check the DirectDraw settings, go to Start > Run and enter 
“DXDIAG”, then click ‘OK.’ From DXDiag, click the “Display 1” 
tab and make sure DirectDraw Acceleration is enabled. Repeat 
this process for the “Display 2” tab if it is visible. 

Finally, do not use any other applications to play video at the 
same time as DivX. Other media players, web cameras and/
or video editing applications may all try to access a resource 
called the hardware overlay, which is generally required for 
high-performance playback. If any other application is using the 
hardware overlay your DivX playback will be sub-optimal.

Rendering
In DivX Player version 6.8.1 and later, you have the option to 
choose which renderer is used for playing back your files. In 
previous versions, DivX Player used the DirectDraw renderer 
by default; however you can now use Direct3D or OpenGL. 

Miscellaneous
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The Direct3D option was put into place as an option that would 
be more compatible with the new Aero environment of the 
Windows Vista platform. 

By default, DivX Player is set to detect the best available 
renderer for your particular environment. If you would like to 
change this however, you can do so from within the Tools 
> Preferences window of DivX Player. Under the Advanced 
section, use the drop-down menu for Video Output to select a 
different renderer. Remember to click the ‘Apply’ button to save 
your changes and always reboot the application before trying to 
play a video with the new renderer.

If you are on Windows 2000 or XP, you should be using 
DirectX version 9. A graphics card that fully supports this and 
PixelShader 2.0 or better is highly recommended.

The Decoder Configuration Utility
If you play DivX video using third-party media players, use 
the Decoder Configuration Utility to adjust settings affecting 
playback performance. To access this, go to your Start menu 
and under All Programs select DivX > DivX Codec > Decoder 
Configuration Utility. 

From the “Decoder” tab, checking the box to “Reduce CPU 
spikes using one frame delay” will help if you are experiencing 
stuttering during playback, especially on older computers when 
playing high definition. Selecting to “Output YUV 4:@:0 when 
supported” can improve playback performance as well, but this 
feature is not available for all graphics cards. 
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The “Playback” tab also has various adjustments affecting 
playback performance. Because of the way DivX compresses 
images at very low bitrates, phenomena known as “blocking” 
and “ringing” can sometimes be seen in the picture during 
playback. Where blocking becomes visible you may begin 
to recognize that the picture is actually composed of a lot of 
small squares that move around as the video plays. Ringing 
is typically most visible around highly contrasting edges in 
the picture. Where ringing occurs it is possible to see subtle 
bands of color around the contours of these edges. You’ll 
see the following choices when customizing your playback 
configuration:

Automatic Deblocking•	  is a post-processing technique applied by 
the decoder on the fly to reduce the blocking effect, helping to 
blend adjacent blocks together smoothly. 
Custom Deblocking•	  lets you set, from minimum to maximum, the 
amount of deblocking you wish to apply.. 
Full Deblocking•	  with Sharpening automatically adjusts the 
post-processing level so that your system always applies the 
maximum possible post-processing during playback. When “Full 
Deblocking with Sharpening” is enabled it may be a strain on 
your CPU power.

Setting the post-processing level to “OFF” is recommended for 
very old computers. On more recent computers, this should 
normally be set to “Automatic Deblocking” to instruct the 
decoder to deblock as much as the CPU can support without 
compromising playback quality. 

Disabling some of the setting in “Picture Properties” or “Film 
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Effect” can also improve playback performance. Most graphics 
cards also allow you to adjust video color using overlay 
controls. To do this, go to the Display Properties > Advanced 
Settings of your Control Panel.

More info
If we still haven’t answered your question, check our online 
knowledge base for more FAQs, guides and troubleshooting 
tips. To discuss topics with other DivX users, you can also visit 
the DivX Forums or take a look at our DivX Labs site.

That’s all, folks. Enjoy DivX Player!


